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PEGASE PRO

Bildosoft.com

User’s manual

CONVENTION
The ALBUM window

The ALBUM window is composed of 4 zones. Only one can be active at a time. A zone is made active by clicking on
it.

Tabs : The zones 3 and 4 contain tabs. A tab corresponds to a function of its area.

TOOL BAR

Definition :

“The current image”: the last image in the album selected by the user.

An image is selected when you click on its thumbnail.

SIZE OF THE ZONES IN THE PEGASE PRO WINDOW
The horizontal and vertical dimensions of zones 2, 3 and 4 can be modified by pointing with the mouse on the zone
separation line.

When the cursor is over a separation, it becomes a line with two arrows and allows to move this separation.

PEGASE PRO
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The position of the separations is automatically saved when the program is closed.

ALBUM
The album has three possible presentations: Board, Picture, List

Click on the tab corresponding to the desired presentation.

BOARD TAB
Display of images as a set of thumbnails,

If Pegase cannot display all the thumbnails on the screen, a scroll bar appears on the right of the album.

To scroll through the boards, you can also use the arrows 17 to 20 of the toolbar.

PICTURE TAB
This tab displays the images of the section one by one.

The size of the display area can be changed by the user.

This tab gives the possibility to scroll through the images without editing them.

To scroll the images: use the arrows on the toolbar.

In all cases the image is resized to fit in the available space.

LIST TAB
Displays the contents of the selected section in the form of a list.

Each field associated with an image is presented in a column.

Change the presentation of the list:

Position the mouse on a column header.

Click on the right mouse button to bring up the list parameters dialog box

Use the « Move Up » and «Move Down» buttons to rearrange the list. You can also use the mouse with the column
headers to interactively move a column.

The Show and Hide buttons to choose which fields to display.

IMAGE STATUS
This is the part of the screen that displays the thumbnails. The information under each thumbnail normally appears in
black.

When a thumbnail is selected in the Album area that has become active :

• The indication changes to blue if Pegase can access the image file.

• The indication changes to red if Pegase cannot access the image file.

If the Album zone becomes inactive, the indications appear in white. The last selection remains active.

Read-only image :

If the user does not have the right to modify the image: «read only» is displayed in the status bar of the software.

STATUS BAR:
The status bar is an information display area.

ALBUM
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In order :

Image [1280 x 1024] : image size in pixels : (Width x Height)

0.842 x 0.3737 mm] : image size in mm

24 bits : image coding format

3840 k : size of the uncompressed image file.

327 k : size of the compressed image file (option).

( 1 : 6 ) : number of images selected : total number of images in the section

SHEET
This area displays the data for the selected image.

If the image is protected against writing « read only » appears in the Pegase Pro status bar.

SHEET TAB
Display the file associated with the selected image.

Select an image and click on its card to modify it. The method used to modify the fields of a card is explained in the
description of the Pegase Pro insertion card.

If the user does not have sufficient access rights, the modifications to the form cannot be validated.

MEMO TAB
Text zone.

This area is intended for free comments associated with the image.

This area supports cut and paste.

The text that appears in this area is that which corresponds to the currently selected image.

The memo can be searched.

If no image is selected, this area is empty.

Data exchange with Excel with cut and paste :

Data separated by tabs are transferred to Excel in different cells. This function is used by the measurement edition.
The edition/measurement module can transmit its measurements in a tabulated form via the clipboard. (button on the
measurement box

CATALOGS AND SECTION

PRESENTATION
A catalog contains sections. A section is the equivalent of a folder in the Windows file manager.

The images in a section are presented by the album as thumbnails.

The image files are not in the section. A section contains only links to images.

A catalog file that is opened when Pegase is closed will automatically be opened again the next time the software is
opened.

When you open or create a new catalog, this catalog is automatically displayed in the catalog area.

The color of the catalogs depends on the user’s access rights to the various open catalogs.

The distribution of images in the various sections is determined solely by the user, who decides how to group his or
her images and on what criteria he or she makes these groupings.

SHEET
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Warning:

Advice: The loss of a catalog leads to the loss of the classification of the images it contained. The images
themselves are not lost. Think about backups.

CREATION OF A CATALOG
Only Pegase Pro can create a catalog file.

A catalog is created with the “new catalog” command in the File menu.

5.3. STATUS OF THE CATALOGS

The color of the catalog icons warns the user of the status of the catalog:

• Green catalog icon: accessible for reading/writing

• Gray catalog icon: Accessible in read-only mode

CREATION OF A SECTION
The section is the basic element of Pegase Pro classification.

All images classified in Pegase Pro appear in one or more sections.

You can only put images in a section.

To put images in a catalog it must contain at least one section.

Create a new section:

Command “File/New section”.

Button 2 on the toolbar.

The name “document” is automatically assigned to the new section. If you type in a new name just after creating the
section, this name automatically replaces “document”.

Press “enter” to validate the new name.

In a catalog, you can create as many sections and sub-sections as you wish.

SECTION NAMES
A section is a folder in a catalog.

A section is represented by a small yellow or gray rectangle.

An album can contain any number of sections. Sections can be arranged in a tree structure, like folders on a hard
disk.

When a section is created, its name is “document”. The user can immediately change the name of the section to the
name he or she has decided to give to the new section, or change it later.

To change the name of a section :

click on its name “document” which will reverse video and appear in a text editing window.

You can type your text or use the usual functions: copy/paste, cut, delete with the “backspace” key.

The name of a section is limited to 255 characters

Characters not allowed : same as Windows files

Either : ? / : * ” < > |

The catalog is not a section. You cannot pull images directly from the root of a catalog

Note that deleting an item in the tree structure will delete all items below it.

CREATION OF A CATALOG
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SELECTION OF A THUMBNAIL
The name of a thumbnail can have several colors that indicate their status:

• Blue: this image is available (i.e. if PEGASE PRO can effectively access the file containing this image).

• Red : this image is not available because Pegase the image file cannot be accessed. Access to the file is solely
the responsibility of the operating system. The cause of this unavailability must be sought in a modification of
access rights, of directory or volume names, … and not in Pegase Pro.

SELECTION OF SEVERAL IMAGES OF A SECTION

TO SELECT SIMULTANEOUSLY SEVERAL IMAGES :
Press and hold the Ctrl key

Click successively on several thumbnails of the section.

The images may not be on the same page, but must be in the same section.

Do not release the Control key to keep the images.

TO SELECT A CONTINUOUS RANGE OF IMAGES YOU MUST :
Press and hold the Shift key.

Click on the first and last image in the list.

To select several continuous ranges of images: hold down the Ctrl button and press the Shift key.

It is possible to mix the continuous selection mode and any selection mode by pressing successively on ” ctrl ” and
on ” shift ” or conversely.

Recovering a section deleted by mistake:

Click on « Undo » in the Edit menu of the album.

Some operations cannot be undone.

DRAG AND DROP BETWEEN SECTIONS IN PEGASE PRO
If you select a section by clicking on its yellow icon :

The drag and drop moves the selected section and everything in it to the section where the operator releases the
mouse. The location of the image files is not changed.

If a thumbnail batch is selected: The thumbnail batch will be transferred to the target section.

Modification of the drag and drop behavior: If you hold down the Control key (Ctrl) before selecting one or more
thumbnails, a section or a catalog, the drag-and-drop performs a copy instead of a move.

Warning:

If the owners or permissions of the catalogs or documents to be moved do not allow the operation, the move is
refused, this is shown on the endpoint by the symbol “xx”.

For example, since a catalog in gray is by definition read-only, any drag-and-drop on one of its sections is
impossible.

Undo a drag and drop (see the “Undo” command in the Edit menu):

Undo the last operation(s) performed on the sections or on the references of a section.

As long as the command is active, it is possible to undo the operations.

Performance:

Pegase Pro is designed to handle many catalogs and large quantities of images and sections without difficulty.

SELECTION OF A THUMBNAIL
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The performance is very dependent on the machine and the network used. The first element to look at in case of
slowdown is the performance of the network link, firewalls and antivirus.

Generally speaking, it is necessary to maintain a “humanly manageable” classification and section content by
cleaning up and separating large masses of homogeneous images in separate catalogs.

IMAGE

ALBUM CARD

DEFINITION
The zone n°4 of the album is read-only, it presents a permanent view of the card associated with each image.

You can define which field will be displayed. You can also define the order in which the fields are displayed. If no
image is selected, a right click on the card brings up the configuration menu of the card.

You can choose the fields and the order of the fields displayed.

Depending on the tab used, different functions are available with the right click of the mouse.

MODIFICATION OF THE FIELDS OF A FORM
If you click on this area when only one image is selected, the form associated with the image appears. You can then
modify all the fields displayed according to your needs.

REPLACEMENT OF A FIELD VALUE FOR A SET OF IMAGES.
If you click on this field when two or more images are selected, the replacement dialog box appears. With the help of
this box, you can modify the content of one or more fields of the records of a set of images at once.

To select the fields in which you want to replace, simply check the corresponding boxes. In the search area, enter the
text you want to find in the selected fields.

The Replace zone must contain the word replace.

By not putting anything in the “search” zone, you indicate to Pegase Pro that you want to replace only in the empty
fields.

Conversely, by leaving the “replace” zone, you delete the word you are looking for.

Note: only the word searched for is replaced, the rest of the field content remains unchanged.

If you click on this area with the right mouse button, a dialog box appears. It is used to choose among all the
available fields (list on the left) those that you really want to display and in which order.

INSERT IMAGES IN A SECTION

PRINCIPLE
Regardless of the origin of the image:

• Images coming directly from the capture or from a Twain device

• Images coming from a file read by Pegase,

• Images entered by drag and drop,

• Images coming from the database and on which you have made modifications or images that you simply want
to duplicate.

The same dialog box appears: “INSERT NEW IMAGE”.

All the information necessary for Pegase Pro can be added with this dialog box.

IMAGE
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This data is essential. Without their presence, PEGASE could not implement certain functionalities.

Two images can have the same file. PEGASE PRO manages its own internal numbering of images.

Preparing to use the Pegase Pro database.

• A preparatory work is necessary: Determine how the images will be identified: field names, number of fields.

• Classification: Organization of catalogs and sections

• Glossary: to have always well filled out forms

If this work is not well done, the operation of the software can become difficult. The reorganization of a poorly thought
out organization can be complex.

INSERTION DIALOG BOX
Presentation of the insertion dialog box :

This box has four areas:

1 Indicates the destination of the image. ( the section currently selected ) The browse button allows you to change
this destination. This change is only valid for this image. To permanently change the destination you must select
another section in Pegase Pro.

2 Input zone for information that the user can associate with this image, as well as the creation of model insertion
sheets that can be memorized and recalled. The « Automatically apply to all new documents » checkbox is used
when using the automatic insertion functions or the file capture. If the box is checked, the file capture dialog box
opens only for the first image and is automatically applied as a template to the other images in the batch to be
inserted.

3 Choice of optical system. The optical systems describe the shooting equipment available to the user. This
information depends on each user. There is no optical system when the program is installed. To create optical
systems, you must use the administration menus in the album or in the edition.

4 Memo zone for free input of comments.

Zone 1 - referencing documents

When the Ok button is pressed, the following sequence of actions is performed:

1. The Pegase image file is formed with the image and the data provided by the user.

IMAGE
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2. The image file is placed in the Pegase image folder (the default folder or the one specified by the “volumes.txt”
file).

3. The information and the thumbnail are inserted in the local database.

4. The image is shown in the section specified by the “Reference document(s)” field.

The destination section of the image is the section selected in Pegase Pro.

You can use the “Browse” button to display the catalogs and sections accessible to the current Pegase Pro user.

Only the catalogs accessible in writing are displayed in the dialog box:

This change is only valid for this image.

Zone 2 - « Data sheet »

The area “data sheet” is used to enter the descriptive information of the image.

Other fields exist like the date and are automatically entered by the user.

The left column displays the name of the field,

The right column is used to enter the data.

Entering data in a field

If the image comes from the pegase video capture.

The “Title” field is: %SYSTEM%%INDEX% :

The character string between the two %’s corresponds to:

• “SYSTEM” = name of the current optical system

• “INDEX” = index number of the photo.

• “SYSTEM ” is a variable that is replaced by the name of the optical system when the image is inserted into
Pegase Pro.

• “INDEX ” is replaced by the number of images recorded in Pegase since the start of Pegase Pro. This value is
reset to zero when the Pegase Pro software is started again.

These two variables can only be used in the title field.

The user can compose an indexed title model:

define a template containing %INDEX% .

Select this template.

Check the box ” Apply the template “.

For example, if you create a template with the title field :

• « Capture %INDEX% ».

• If we select and apply this template, all the images will have the title Capture 1, Capture 2, …

These two variables are only managed by Pegase Pro in the Title field.

An optional module offers other possibilities. Custom developments can also be done on demand.

If the image does not come from the video capture. The title field contains the name of the file or the term
“document”.

IMAGE
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You can also use the %xxx% variables, the templates.

There is no automatic indexing.

Entering data in a field of the record.

The fields can contain any type of character and several thousand characters. The Title field is used as a name when
exporting images. If it contains characters that are not allowed by Windows the image cannot be exported.

In any case :

USE OF THE GLOSSARY :
A glossary is a list of predefined words. You can define a list by field. You can also have lists that do not correspond
to any field.

To see the dialog box appear, you must make sure that at least one glossary is available: Use the “Glossary
management” command in the “Options” menu of the Album to create and modify a glossary.

If a glossary is available, simply place the mouse cursor over one of the field names in the record and click the right
button. The list of words corresponding to this field is displayed. If the list corresponding to the field name is not
displayed, there is an error in the glossary definition.

It is possible to select another glossary field using the list box.

When Pegase Pro has just been installed, no glossary is defined. This command therefore has no action.

USE OF THE MEMO ZONE :
The memo allows to answer needs not foreseen in the fields and in the keywords.

You can search in the memo as in the other fields of the form.

When cutting and pasting data from the memo to Excel, the tabulated data is sent to separate Excel boxes.

USE OF PRE-FILLED INSERT CARDS :
A sample form is a Pegase pro form where some fields contain data.

IMAGE
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You can only create a type sheet in the image insertion box

At any time it is possible to create a model card from a card that has just been entered.

Click on the button “save as template”.

A dialog box “save as” opens to allow the user to give a name to the file template.

The Pegase Pro directory of the user’s current directory is proposed by default, to finish, enter the name of the file
and click Ok.

To use an existing model file: - Click on the “browse” button located at the top right of the Data sheet zone to select
a model sheet file. - Check the box “apply template” to apply the chosen template to the current form. - Do Ok when
all the elements of the form are filled in…

Reset button

This button :

Deletes all data from the fields of the current form.

The data of the memo.

Resets the default value of the Title field.

DRAG AND DROP BETWEEN PEGASE PRO AND EXPLORER
The PEGASE album supports DRAG AND DROP of image files.

Select image files with the file manager. Hold down the left mouse button, drag all these files to the target section of
Pegase Pro. The section must exist before the drag/drop. As soon as the left button is released the usual dialog box
for inserting a document into a base opens.

Important note: The document insertion dialog box can be presented when the first image is inserted or at each
image. You can select either mode by using the “Automatically apply to all new documents” checkbox.

PEGASE will automatically integrate these images into the database.

The images are saved with the type of compression set in the “Default compression rate” command in the “Options”
menu of the main window.

Recovery of a file in Pegase Pro format.

Without changing the directory of the file:

You can « drag and drop » image files in pegase pro format (xxx.DAT).

The image contained in the file appears in the target section as well as all associated data. But the file remains
located in its original directory and not in the pegase pro volume files.

By changing the directory of the file :

• By pressing the SHIFT key while dragging, you can change this behavior. Pegase Pro does two actions
simultaneously:

Insert the document in the requested section

Move the DAT file to the active volume of Pegase Pro files.

Recovery of a Pegase Pro file from the recycle garbage can:

It is advised to proceed as follows:

Move the image from the recycle garbage can to an intermediate directory of your choice

Move the image from this directory to the Pegase Pro section of your choice (using the SHIFT key to also put the
image file in its place).

IMAGE
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Use of a template

PEGASE automatically asks, in the image insertion dialog box, to load a template or to save a form as a template. A
check box is used to validate this template permanently or not.

Note: to create a template, you must enter an image by dragging and dropping it to access the template saving
menu, even if you have to cancel it as soon as the template is saved.

DUPLICATION OF AN IMAGE FROM THE DATABASE
The same image can appear in many sections even though there is only one file present.

To create a new file from an existing image, it is necessary to use the “duplicate image” command.

This command copies the image and the associated file.

SEE AN IMAGE IN SEVERAL SECTIONS
Pegase Pro can make a file appear in one or more sections.

To see an image in several sections of one or several catalogs, it must be referenced in all the desired sections.

For example, this function can be used to create a catalog of samples from a laboratory.

This function is used by the search itself, which automatically creates a new section and references the images
found in this section.

To create a new reference to an image:

Hold down the Ctrl key,

Click on the thumbnail in the Album window and move the mouse cursor over the icon of the new section where you
want to reference this image.

Remember: if you do not hold down the control key before dragging and dropping, you do not duplicate the reference
but move the reference from one section to another (i.e. the reference in the starting section is deleted)…

DELETE
Pegase Pro makes the difference between ;

• Not seeing an image in a section anymore

• Permanently deleting an image file

NO LONGER SEE AN IMAGE IN A SECTION:
This operation is called: “delete a reference to an image”.

You can delete one or more references to a given image, or even delete all references to this image.

An image that is not referenced does not appear in any catalog. If the image file was not deleted the last time, the
image still exists in the database but is no longer visible. You can search for images that have become invisible with
the search function: see the example “Search for images that have become invisible”.

TO PERMANENTLY DELETE AN IMAGE
You have to do « delete the image file », a dialog box asks for a confirmation.

LIST OF SECTIONS WHERE AN IMAGE IS REFERENCED
Select this image in the album by clicking on it. Click on the right button of the mouse to access the “Properties”
command of the floating menu and then on the “other properties” button.

DUPLICATION OF AN IMAGE FROM THE DATABASE
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FIND ALL THE IMAGES IN PEGASE THAT HAVE BECOME
“INVISIBLE
Definition of an invisible image

• An image that is saved in the database

• An image that does not appear in any section.

An invisible image is called: « orphan images ».

To search for orphan images :

• Go to the menu: configuration, advanced, search for orphan images.

• The result is presented in a new catalog. An “Orphan” section contains all the orphan images found.

MENUS OF THE ALBUM WINDOW

FILE

ACQUIRE IMAGE FILES
This command inserts the image files located in the “acquisition directory” into the current section.

The files in this directory are automatically deleted after insertion in Pegase Pro.

The path to the acquisition directory is defined by the “acquire directory” variable in the administration parameters.

NEW SECTION

• Select the catalog or section where the new section must be created.

• Click on “new section” a new section appears in the tree structure displayed on the left of the screen, in the
selected catalog.

• The name of this section is: “document”. This name is followed by an index 1, 2, … if there is already a section
called “document”.

By clicking on the name of a section, the zone starts editing. This name can then be changed.

DELETE
See the floating menu for deletion commands.

PROPERTIES OF AN IMAGE
This command displays the characteristics of the image file: owner, access rights, compression mode. This
command corresponds to the button :

Information displayed :

• Its name: name field,

• Type of compression: non-destructive compressed ( std ) or compressed ( jpeg ).

Button « modify the type or the compression rate of this image ».

Calls the following dialog box which is used to change the type of compression or to accentuate the compression in
the case of Jpeg :

FIND ALL THE IMAGES IN PEGASE THAT HAVE BECOME “INVISIBLE
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The Permission button:

brings up the new dialog box shown below, which is used to determine which users can access the selected images,
and the nature of this access. By default, the permissions are as shown in this dialog box, i.e. Full Control and Read :

The add button is used to add new users to the list of those who have access to the document. (See the description
of the “add” button in the menu administration/management/user_group”).

The “remove” button removes the selected user.

To change the access rights of a user, select the user’s name, then click on the arrow to the right of the “access type”
field and select the desired access type.

• Special access (from the permission box) :

This command gives access to additional safeguards while giving the possibility to change also the basic safeguards.
This function is intended for computer specialists.

The button « save the security of this document as a template »

With this command you can obtain a file that can be used by a macro or an external program.

By clicking on special access, you will find the three basic properties

• Total control (All)

• Read (R)

• Write (W).

And three new properties:

Delete : _case “delete” attribute (D). Checking this box only prevents the image from being deleted, but not from
being modified.

Change the permissions associated with this image: _case “Change permissions “s , attribute (P)

Become the owner of a document, attribute (O).

The “Membership” button:

Displays the owner of the image.

This information can explain for example:

• why an image is read-only

FIND ALL THE IMAGES IN PEGASE THAT HAVE BECOME “INVISIBLE
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• who created the image

The appropriation button is used to become the owner of the image. The previous owner is forgotten. You can only
appropriate an image if you have full control over it. The user.

Appropriation can be used to transfer images from one owner to another via the administrator for example.

Encrypt content to secure data

The content of the file can be encrypted to prevent it from being read when it is sent by email or when a file is
transferred. The encryption is irreversible.

Other properties

This dialog box displays all the sections where selected is classified.

PROPERTIES OF A CATALOG

PERMISSION

• This command is used to restrict access to a catalog to certain users.

To change a user’s permissions, select the user’s name and then the desired permission using the drop-down box.

If the user does not appear. Click on the Add button and search for the user group or user.

• There are 3 types of users, administrators, designers and users

Administrators have all the rights

Designers can create, delete and modify sections and of course enter images.

Users can only use existing sections and catalogs.

If a user is an owner, he has all rights. To set up a security scheme, you have to assign users to a catalog that they
are not the owner.

APPARTMENT

•  

SEND TO
This function calls directly on the MAPI-compatible email program installed on the machine where PEGASE is
located. The mailbox can be Microsoft Outlook or another program.

Command is grayed out: no MAPI software or service is available for the Windows login used.

If a mailbox is available, the pegase pro file is added as a document associated to a new message. The user will
have to complete and send the message by himself.

IMPORT SECTIONS
This command is used to load an existing section file. The loaded sections are inserted from the current section.

A section file is created from the « export sections » command.

An image appears in a section if the image file is accessible to Pegase Pro.

CONFIGURATION OF THE PRINTING.
This command is used to access the configuration dialog boxes of the printing peripherals.

It is also used to set the margins of documents printed by PEGASE.

FIND ALL THE IMAGES IN PEGASE THAT HAVE BECOME “INVISIBLE
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For more details on the layout, refer to the chapter “Modification of margins for printing reports” in the “Tools” menu
of the Album.

EXIT
Quits editing and closes PEGASE.

NEW DOCUMENT
This command is used to insert images from existing image files into a section.

EXPORT

Export the document

This command is used to save the selected image to a file. The choice of the target directory and the name of the
image is made using a standard dialog box.

The available file formats are: BMP, Jpeg, Tiff

At the same time as the image is exported, a file in txt format (standard Windows text) is automatically generated.

This file contains the information associated with the image in text form.

Reminder: If this command is grayed out, it means that no image is selected. To select an image, click on its
thumbnail.

Export sections

This command creates a file containing the selected tree structure and the numbers of the images it references.

importing sections into a pegase database means applying a ranking directly to the images referenced in the
sections.

If, after importing a set of sections, Pegase Pro does not find the information on certain images, it will try to load this
data from the corresponding document files (which must therefore be available at the time of import).

These images must therefore be “online” in one of the volumes to which it has access. Otherwise, these images are
ignored (without any consequences on the global functioning of Pegase Pro, except that the corresponding
thumbnails will not appear! ).

Export the measurements

This command gathers in a single file in « dbf » format all the measurements of the selected images.

For each measurement, the name of the image and the identification number of the corresponding document
(because the images may have the same name in the album).

Export in standard resolution

Unlike the export of the document, which retains the calibration information, this command replaces this information
with a standard resolution (96 dpi) so that the image behaves in Word or other software as an image without any
calibration.

PRINT SECTION

Image(s) only

This “Images” command prints all the images in the section on separate sheets and in a format chosen by the user.

Each image is printed on an individual sheet, in a format chosen by the user using a dialog box identical to the one
presented for the command in the “print image only” submenu, and in the “print image” menu on the previous pages.

FIND ALL THE IMAGES IN PEGASE THAT HAVE BECOME “INVISIBLE
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Print the board

This command sends to the printer all the images of a section or selection, organizing their presentation as a contact
sheet:

N lines of M images.

The name of each image appears below the image.

When this command is selected, PEGASE asks the user to enter the number of columns that the plate should have.

The width of the columns is automatically calculated by PEGASE according to the page margins.

Printed thumbnail dimensions :

Since the images do not all have the same dimensions, each image is scaled before being printed.

PEGASE preserves the proportions of the image and automatically calculates the scaling ratios.

Based on the previous settings PEGASE prints the section on the number of pages required to print all the selected
images.

Thus, when printed, all images have the same apparent size.

NOTE

The formatting work that PEGASE must do can be significant. Since some printers do not have much memory, the
time required to print a section with many images can vary greatly from one printer to another.

PRINT THE SELECTION

Print image(s) only

This is used to print the current image in various formats

Print format

The dialog box offers :

4 predefined image formats:

” 6x8 cm “, ” 10x13 cm ” ” 13x18 cm “, ” 18x24 cm “

And 1 Custom format for which the user defines the desired height and width of the print (attention, in millimeters).

The dimensions must take into account the capacities of the printer used. Please refer to the documentation of the
printer to know its possibilities. It should be noted that the printer manufacturer’s driver carries out the scaling at the
request of PEGASE. It is therefore possible that an inaccuracy may exist which may vary according to the type of
printer and the version of the driver for this printer. The selection of the correct printing format is made by clicking on
the corresponding check box.

Scale factor - print the image at a given magnification:

For example, if you choose magnification 100, the image being calibrated and measuring 1 mm wide at the origin,
Pegase will ask the printer to print an image 10 cm wide. The printer must have the capacity to print an image of the
requested size with the requested margins.

Be careful, most printers cannot print to the edge of the paper.

Print the overlay :

If this box is checked, PEGASE prints the “Overlay” image superimposed on the image.

By clicking on Ok, the usual « Print » dialog box is displayed for the choice of the printer, the number of copies, …..

Click on the latter to start printing.

To cancel the printing click on the button at the top right of this window.

FIND ALL THE IMAGES IN PEGASE THAT HAVE BECOME “INVISIBLE
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Remarks : PEGASE calculates the right reduction or enlargement ratio so that the image fits in the chosen format
without distortion in all cases.

SEARCH

General information about the search

By clicking on this command you can choose between the four PEGASE search tools:

• Predefined search

• Simple search,

General principles for searching :

With the help of the search tools, it is possible to find images whose record contains a certain number of words or
portion of words.

If you know what you are looking for, if the number of conditions does not exceed 4 and if you want to work on all the
images “known” by Pegase Pro without taking into account the catalogs, you must use the simple search.

If you want to create a more complex logical equation that automatically generates several result sections and limits
the display of results to images contained in certain catalogs, then you should use the advanced search.

Predefined search

This command is used to apply a predefined search.

Clicking on the arrow to the right of the line “Select a predefined template” opens a dialog box where there must be
at least one template for the search of all the unreferenced images (orphan images, no longer visible) in the
database: “orphan.qry”.

• Select this file and start the search.

For other possibilities see the following commands.

Simple and direct search

Each term is linked to the next by one of the two logical operators :

And ( and ) Or ( or )

To validate (put into service) a line, you just have to check the box at the beginning of this line:

The “fields” column is used to choose the title of the field to be searched. To display the different possible fields,
click on the arrow to the right of the drop-down list in the fields column.

The operator column is used to select the comparison operator used with the field.

The “values” column is used to enter the text you are looking for. Be careful, this search is based on the exact word.
It does not tolerate typing errors.

FIND ALL THE IMAGES IN PEGASE THAT HAVE BECOME “INVISIBLE
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To activate a condition line, click in the check box on the left of the line.

The option « Synchronize the document files and the local card base before searching » is used to ensure that the
search will be done on all the available images. The synchronization time can be very long depending on the network
and the number of images online. On a large base, it is necessary to allow for the time necessary for the system to
do its work.

REQUEST: VOLUME OCCUPIED BY A RESULT
Even if a lot of images are selected, this has practically no effect on the memory occupation of the disk.

Indeed, it should be remembered that PEGASE only duplicates references to images and not the image files
themselves….

EDITION

CANCEL
Cancels the last operation(s) performed on the sections or on the references of a section.

As long as the command is active, it is possible to cancel operations.

CUT
Function reserved for later use.

COPY
The image file is put in the clipboard. Only software that requires an image (paint, photoshop) will be able to recover
the image. To be sure to retrieve the image systematically, use ” copy image only “.

COPY THE IMAGE ONLY
This command only puts the image file in the clipboard. This command is particularly convenient with Word.

PASTE
Inserts the contents of the clipboard (which is an image) into the current section, as a new Pegase document. The
form dialog box appears and invites the user to enter the data concerning this new image. If you want to recover the
information from the original image, use the following command “paste by duplicating”.

PASTE BY DUPLICATING
Unlike the paste command which creates a new image with a new card, … this command duplicates the existing
document with everything it contains, in the database. No information is therefore requested from the user.

DELETE
Depending on the selected item :

• Thumbnail: deletes the reference, after confirmation,

• Section: deletes the section, after confirmation,

• Catalog: deletes the catalog directly,

• Memo : deletes the text directly

SELECT ALL
Selects all the images in a section at once

EDITION
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REVERSE SELECTION
Within a section, this command selects the unselected images and de-selects the selected images.

This command is very useful if you want to select almost all the images in a section. All you have to do is select the
images you don’t want, then click on “reverse selection”. The unwanted images are then the only ones that are not
selected.

EDIT THE IMAGE… .
Starts the editing module with the selected image as subject. This command is identical to the “double click” on the
thumbnail.

EDIT CARD .
This command is used to modify the contents of the database record associated with the selected image.

For the three zones: Title and user fields, Memo zone, Keyword zone. Text can be entered after clicking on the zone
or on the field.

The right mouse button gives access to the commands necessary to intervene on the existing text.

DISPLAY

MAP
This command is used to scroll through the various boards that display the images in a section.

DISPLAY
This command is used to determine on which criteria pegase should sort the album before displaying the images.
The possible choices are:

• Title,

• Date,

• Size,

• another field.

The choice « another field » is used to sort on any field, including on a user field.

SORT

Automatic sorting :

The content of the text box below the thumbnail is set by the user independently of the sort order of the section itself.

By selecting one of the following commands:

Title, Date, Size, Another field, Define custom sort, the content of this area is set.

Note : The sort order and sort field are saved for each Pegase session. You may see thumbnails that display a given
field, but whose order is calculated on another field (the sorting field). This can result in a display contrary to what
one would expect if the sorting and display fields were the same.

Manual sorting :

It is possible to define the order in which images appear in the album in which they appear.

By clicking on the command “Define a custom sorting …” a dialog box appears. The upper line is used to select the
field whose content will be used to identify the image when defining the order of appearance. Below, the display area
shows the list of values corresponding to the selected field and to all the images in the active section. To select an

DISPLAY
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image that you wish to classify, simply click on the value of the field that corresponds to it. The corresponding image
will then appear on the right-hand side of the list for checking.

The “Up” and “Down” buttons allow the user to change the position of the image in the list. The first image in the list
will appear first in the section, etc.

Please note that the buttons A -> B and A <- B reverse the display order.

On opening, the order corresponds to the old sorting order and is initialized as is.

If an automatic sort is chosen later, all manual sorting is lost.

The sorting order appears the same on all Pegase pro workstations, but only authorized users can permanently
modify it.

UPDATE
Updates the album with the last modifications of the image and the associated file. This function works for an image,
a section or a catalog.

Shortcut for the function: “F5” key.

TOOL BAR
The floating toolbar can be moved anywhere on the screen. For example, it can be moved vertically to the sides, or
even off screen…

The “Toolbar” command is used to make it reappear horizontally, under the menus.

SYNCHRO
See the documentation of the synchro module.

The synchro is only usable with a pegase pro workgroup.

DOCUMENT HOLDER
The Pegase Pro document holder is active if the Pegase synchro “is activated”.

The document holder is a local storage area for Pegase Pro images. It allows you to work on a catalog or on images
in disconnected mode.

The user who wishes to work on his images and catalog, add, delete or modify images can use the document holder
to take with him the images he needs.

The document holder will receive the new images.

When the software reconnects to the network, it tries to synchronize the documents on the Document Holder with
those on the server.

The files in the document holder remain local until they are removed.

To put all or part of a catalog in « local copy » mode, use one of the 3 “Add…” commands.

To put the images of the document holder back to the server, use one of the 3 “Remove…” commands.

The command « See the content » creates a section. This section presents all the Pegase Pro images in the
Document Holder directory.

Empty the document holder permanently deletes all the images in the document holder.

SYNCHRO
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TOOLS

ASSOCIATED DOCUMENTS
This command calls the « Hannibal » module. This module gives access to the documents associated with the
image. This module is more complete than the “Associated documents” tab in the album’s file area. See the
documentation of this module for more details.

IMPORT A RAW FILE
This command allows you to import non-standard format files but whose characteristics are known:

The characteristics taken into account by Pegase Pro appear in the following dialog box:

REACH A DOCUMENT

OPTIONS

CHANGE THE PASSWORD .
This command is used to change the password of the current user or that of the administrator if you are in
administration mode.

CHANGE PRINTING FONT
This command is used to change the printing font that PEGASE will use when printing text in the reports.

Clicking it brings up the standard Windows dialog box:

These settings are used by Pegase for all printing.

GLOSSARY MANAGEMENT
Definition

A predefined word is simply a word that the user has decided to use systematically.

The user builds up a list of words that he can use afterwards without typing them again.

The set of words corresponding to a given function constitutes a glossary.

More than a word, the whole line is a glossary entry.

No acceleration or indexing is done on these words because they can be changed at any time.

Each field of the database can have its own list of predefined words.

You can create as many lists of predefined words as you want.

TOOLS
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Note:

By identifying a directory containing a glossary, several network users can use the same glossary file.

Using the predefined words

To see the list of predefined words associated with a field, click on the right mouse button while the cursor is on the
field in question,

A small window appears containing the list of available predefined words. The name of the field in question is shown
in the title bar of the predefined words window. It is therefore possible to ensure that the list corresponding to the
desired field is displayed.

Create a list of predefined words or Glossary

It is used to indicate to PEGASE the file that it should use to find the entries of the predefined words. This file is a
standard text file containing a number of words delimiting the zones containing the predefined words.

Here are the contents of the file Test.txt whose name appears in the dialog box above

[Title]

[Created by]

[User field 01] word1 word2 word3 [User field 02]

[User field 03]

[User field 04]

[User field 05]

[User field 06]

[User field 07]

[User field 08]

[User field 09]

[User field 10]

[User field 11]

[User field 12]

[User field 13]

[User field 14]

[User field 15]

[User field 16]

The zone: [User field 01] has been filled in by the user with three predefined words

• word1

• word2

• word3

These words did not exist when the software was installed. These are the words that reappear in the keyword
window of user field number 1 when filling in the file associated with an image. In this file you must leave all the
labels in square brackets, even if there are no predefined words. Each predefined word must be on one line and
must not exceed the maximum length of the field concerned. The end of a keyword is the first blank or carriage
return. Everything following a blank is ignored.

Note :

It is possible to enter in the glossary items other than those of the field names of the form associated with an image.

To see the keywords associated with these fields, simply select the field from the list of available fields.

By clicking on the first letter of the field in the field area, PEGASE PRO automatically positions itself on this field.

If other words begin with the same letter, they will appear successively if you type the letter again.

TOOLS
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The same assistance is available even for the values of these fields displayed in the “select one or more terms” zone.

MENU TOOLS .
The tool menu is managed by an xml file named “album_tools”, located in the folder of the same name in the
pegase installation folder.

A menu item is designated by the following lines, which can be duplicated and modified

<tool>

<command>link or command</command>

<label>menu name</label>

<arguments></arguments>

<initialdir></initialdir>

</tool>

UPDATES OF LOCAL FILES
This command performs :

A complete refresh For each reference, searches for the most recent record among all the record bases to which
Pegase pro has access.

Be careful, this operation is only done between the card bases and does not modify the image file and its data. This
command can therefore be used when the images are not accessible.

This command only works on the root of a section and can be long depending on the importance of the work to be
done.

IMAGE CALIBRATION
This command works as in the measure edition except that it applies to the batch of selected images. It is therefore
extremely useful if the correct type of magnification was forgotten during a series of images taken. This command
avoids the tedious task of opening each image in the measurement edition to correct the calibration.

RENDERING PARAMETERS
This function is used to control the image dimension information exchanged between Pegase pro and other
applications.

You can either choose to work with the magnification, or to use the more bureaucratic notation of resolution in
pixel/mm frequently used by Pao software.

If you do not check the box “Use a specific resolution”, the “magnification factor” is used and vice versa.

• Magnification factor : the size of the image is multiplied by this factor and transmitted to the program via the
clipboard or the automation (Word, Excel or programming report). The display will be done accordingly if the
receiving application knows how to manage the dimension of an image. This is a method for, for example,
retrieving images at “100 magnification” in Word.

• Specific resolution : the real size of the transferred image is erased and replaced by the resolution information.
For example, the usual resolution set by default by a drawing application is 96 dpi (dot by inch), i.e.
approximately 38 dots per millimeter. By entering these values for the two resolutions, the images that go
through the clipboard will appear as if they were “normal” in Word or Photoshop.

These parameters are automatically memorized and valid for all the images and the automation.

TOOLS
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FLOATING MENU

GENERAL
A floating menu is obtained by clicking on a certain area of a window with the right mouse button.

The menu that is displayed depends on the area where the cursor is located when you click.

It groups together for this area, or for an object, functions that are distributed in various menus in the album.

For a description of the commands in a floating menu, we will generally refer to the menus and commands described
above.

Only the commands that are not present in any other Pegase Pro menu will be described below.

PROPERTIES
This command in the floating menu functions in the same way as the properties command in the Album file menu:

• From an image: by having previously clicked on a thumbnail .

• A catalog and the sections it contains: by clicking on the catalog icon.

For information on these functions, see the corresponding menus in the album window.

DELETE
The function of the delete command depending on the object selected is described below, for each object or area of
the album window.

• Remember: you can delete either the reference to an image or the document file itself.

Principles:

• The “delete / reference” command has the same function as the “delete” command in the Edit menu.

• The command ” delete / the document ” has no equivalent in Pegase Pro.

DELETE (FLOW MENU ON SECTION OR ON CATALOG)

• On Section : deletes the section, but not the images themselves. This section can be restored with all its
references using the “Edit / Undo” command, as long as this command is accessible (it is not grayed out)

• On catalog : deletes the reference to this catalog, i.e. its display in the section area of the screen located on the
left of the Album window.

This catalog is still in Pegase. It can be displayed again with the “Reference a catalog” command.

For each of these two operations, a dialog box asks for confirmation of the deletion.

DELETE (FLOW MENU ON THUMBNAIL - TAB PANEL)
This command offers the following two possibilities:

Delete reference :

Removes the link between the displayed section and the image. This reference can be restored using the ” Edit /
Undo ” command, as long as this command is accessible (i.e. it is not grayed out)

Reminder:

This command leaves the other links unchanged. The image file can be referenced (the thumbnail is visible) in other
sections and catalogs…

The file is not deleted. If this image file is no longer referenced in any catalog, the image will be said to be
“orphaned”. A search mode is provided to detect and reference or delete these orphan images.

FLOATING MENU
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Delete the image file :

Unlike deleting a reference, this command permanently deletes the image file and all associated data. The thumbnail
disappears from all sections where it appeared.

Notes on deleting documents :

This floating menu command is the only one that gives the possibility to delete the image file itself.

RECOVER A DELETED DOCUMENT
It is not possible to undo a document deletion in Pegase Pro, but it is still possible to recover this document.

A deleted document being found in the Windows recycle garbage can, it is possible to use the command “restore” of
the recycle garbage can to recover the file in question. This recovery is possible even if Pegase and Windows have
been closed, provided that the recycle garbage can has not been emptied in the meantime.

Implementation :

With the Windows explorer display the content of the recycle garbage can.

Click on the date field to obtain a classification by date which will bring the file you are looking for to the top of the list
if it has just been deleted, or a little further down if it is older.

• Make a note of its name (at least the first 6 letters or numbers; or, for more security, all the characters)

• Do “restore” after having clicked with the right button of the mouse on the file previously located and selected:
the file is then put back to its initial place in the “FILES” directory of Pegase (if it is the default directory used by
Pegase). But the document is not referenced anymore.

• By using the drag and drop between this file located and selected in the FILES directory and the section
concerned in the album tree, this image will reappear in this section.

Note: Since it is not possible to know where a document was referenced, other referencing will not be restored.

COMPARE TO SCALE (ON THE IMAGE TAB OF THE ALBUM)
This function is performed on the “image” tab of the album zone. It consists of comparing a selected image with
reference images.

Principle of the comparison to :

The image tab window is divided vertically into two equal parts:

In the left part an image selected from a given section is displayed as a reference, this one occupying the maximum
possible space.

In the right part you can scroll through the images of this section or of another section.

The calibration of the image on the left is used as a dimensional reference for the image on the right. Each time it
needs to display an image in the right section, the software adapts the image size so that the pixel size of the two
images is identical. If the images were made at the same magnification, the image is displayed normally. If you try to
compare images of different magnifications, the image on the right will be enlarged or shrunken as appropriate. This
visual effect instantly indicates the error to the operator. (This change of dimension only occurs for the right image).

Preparation:

After opening, in the “Image” tab, the image that will be used as a reference, click on the “Compare to
Scale/On/Off” command.

The commands:

On/Off: turns on or off the compare to scale mode.

Change: when the scale comparison mode is active, switches the image from right to left. After this command, the
two images displayed are identical.

FLOATING MENU
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ASSOCIATED DOCUMENTS
The “associated documents” module is an independent program of Pegase Pro which gives the possibility to put in
the image file all kinds of documents. A specific help file is available on this subject.

FLOATING MENU ON THE “MEMO” AREA
The commands in this menu are used to manipulate the text contained in the memo associated with an image.

If the content of the memo comes from the Measurement-Editor, tabs have been automatically added by Pegase to
ensure that the measurement data will be placed directly in Excel columns if you use the cut and paste via the
Windows clipboard.

Indices and tables
• genindex

• modindex

• search
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